
Suite 201 – 1571 Bellevue Ave., West Vancouver, British Columbia,  Canada  V7V 1A6 • Tel: 1.604.926.3261 • Fax: 1.604.926.5389 • www.hatfieldgroup.com

Earth Observation Support for Traditional Ecological Mapping 
and Biodiversity Conservation in Viet Nam (EO-STEM) Project:
Work Package No. 2

Milestone 7 Report: Guide to Remote Sensing Field Data Collection
Forest Cover Survey in Thua Thien-Hue, Viet Nam

August 2006

Prepared for:

Canadian Space Agency
Saint Hubert, Québec

Prepared by:

Hatfield Consultants Ltd.

This document contains information proprietary to the Canadian Space Agency or to a third party to which the Canadian Space Agency 

may have legal obligation to protect such information from unauthorized disclosure, use or duplication. Any disclosure, use or 

duplication of this document or of any of the information contained herein for other than the specific purpose for which it was disclosed 

is expressly prohibited except as the Canadian Space Agency may otherwise agree to in writing.



Suite 201 – 1571 Bellevue Ave., West Vancouver, BC, Canada V7V 1A6 • Tel: 1.604.926.3261 • Fax: 1.604.926.5389 • www.hatfieldgroup.com

 

EARTH OBSERVATION SUPPORT FOR 
TRADITIONAL ECOLOGICAL MAPPING AND 

BIODIVERSITY CONSERVATION IN VIET NAM 
(EO-STEM) PROJECT 

 
(CONTRACT NO. 9F028-4-5007/01) 

 
MILESTONE 7 REPORT: 

GUIDE TO REMOTE SENSING  
FIELD DATA COLLECTION 

FOREST COVER SURVEY IN THUA THIEN-HUE, VIET NAM 

 
Prepared for: 

CANADIAN SPACE AGENCY 
6767 ROUTE DE L’AÉROPORT 
ROOM 1 E-103E (MAIL ROOM) 

SAINT HUBERT, QUÉBEC 
J3Y 8Y9 

 
 

Prepared by: 

HATFIELD CONSULTANTS LTD. 
SUITE 201 – 1571 BELLEVUE AVENUE 

WEST VANCOUVER, BC 
V7V 1A6 

 
 

AUGUST 2006 

STEM1173.2 



EO-STEM Milestone Report 7 i Hatfield 

TABLE OF CONTENTS 

LIST OF FIGURES......................................................................................... ii 
LIST OF TABLES .......................................................................................... ii 
LIST OF APPENDICES ................................................................................. ii 
ACKNOWLEDGEMENTS............................................................................. iii 

1.0 INTRODUCTION.................................................................................. 1 

2.0 BASIC PRINCIPLES OF FIELD DATA SURVEY................................ 2 
2.1 THE NEED FOR A FIELD DATA SURVEY ..............................................................2 
2.2 SATELLITE IMAGERY.............................................................................................2 
2.3 CLASSIFICATION SYSTEM....................................................................................3 
2.4 PLANNING A FIELD DATA SURVEY ......................................................................3 
2.5 SAMPLING FREQUENCY AND DISTRIBUTION.................................................... 4 
2.6 SURVEY EQUIPMENT ............................................................................................5 
2.7 REQUIREMENTS FOLLOWING A SURVEY...........................................................5 

3.0 LAND COVER SURVEY IN THUA THIEN-HUE, VIET NAM .............. 6 
3.1 OBJECTIVE .............................................................................................................6 
3.2 CLASSIFICATION SYSTEM....................................................................................7 
3.3 AREA OF INTEREST AND SURVEY PLAN............................................................ 9 
3.4 SURVEY TEAM......................................................................................................10 

4.0 PROTOCOL FOR FIELD DATA SURVEY......................................... 11 
4.1 EQUIPMENT SETUP ............................................................................................. 11 
4.2 DATA COLLECTION FORM ..................................................................................12 
4.2.1 General Information..........................................................................................12 
4.2.2 Waypoint Information........................................................................................12 
4.3 DATA RECORDING PROTOCOL.......................................................................... 13 

5.0 PROCESSING OF FIELD DATA ....................................................... 15 
5.1 DOWNLOADING GPS DATA.................................................................................15 
5.2 FIELD DATA ENTRY..............................................................................................15 
5.3 PHOTOGRAPHS ...................................................................................................16 
5.4 CREATION OF GIS DATA .....................................................................................17 
5.4.1 ArcGIS 9x .........................................................................................................17 
5.4.2 ArcView 3x........................................................................................................17 
5.4.3 Appending Attributes ........................................................................................18 
5.5 GEOCODING GPS PHOTOGRAPHS ...................................................................18 
5.6 RESULTS OF THE THUA THIEN-HUE SURVEY.................................................. 19 

6.0 FUTURE WORK ................................................................................ 21 

7.0 FURTHER INFORMATION AND REFERENCES.............................. 23 

8.0 CLOSURE.......................................................................................... 24 
 



EO-STEM Milestone Report 7 ii Hatfield 

LIST OF FIGURES 

Figure 1  Area of interest and coverage of SPOT imagery, Thua Thien Hue 
Province, Viet Nam. ......................................................................................7 

Figure 2 Vietnamese Classification of Evergreen Natural Wooden Forest 
(Ministry of Natural Resources and Environment). .......................................8 

Figure 3 Location of field data surveys conducted as part of the EO-STEM 
project in Thua Thien-Hue Province, Viet Nam. .........................................10 

Figure 4 Survey tracks from the EO-STEM field data survey, Thua Thien-
Hue Province, Viet Nam. ............................................................................20 

Figure 5 Data collection using integrated PDA and GPS devices. ...........................21 

Figure 6 EO-STEM team members recording data in real-time................................22 

 

LIST OF TABLES 

Table 1 Class definition for Vietnamese Classification of Evergreen 
Natural Wooden Forest (Ministry of Natural Resources and 
Environment). ...............................................................................................9 

 

LIST OF APPENDICES 

Appendix A1   Data Collection Form 

Appendix A2   Sample Field Data 

Appendix A3   Sample Photo Catalogue 

 

 



EO-STEM Milestone Report 7 iii Hatfield 

ACKNOWLEDGEMENTS 

The document was produced as part of the Earth Observation Support to Traditional 
Ecological Mapping and Biodiversity Conservation in Viet Nam (EOSTEM) project, which 
was funded by the Canadian Space Agency (CSA) Earth Observation Application 
Development (EOADP) Program. Hatfield Consultants Ltd. implements the EO-STEM 
Project with assistance from a number of Canadian partners, including Strata360 & ÆRDE 
Environmental Research. 

Field surveys were conducted to support the Forest Protection Department (FPD) – WWF 
“Green Corridor Project: Meeting global conservation targets in a productive landscape.” 
This project is a four-year initiative, which started June 2004 with funding under the 
World Bank - Global Environment Facility (GMOA5301). The project also receives 
co-funding from the WWF Greater Mekong Programme, Thua Thien-Hue Provincial 
Peoples Committee and SNV (Dutch International Development Agency). 

A large number of people assisted in planning and undertaking the field surveys, 
including: Dr. Xuan Lan, Forest Inventory and Planning Institute – Hanoi; Mr. Ha and 
Mr. Phong, Forestry Planning Group, DARD, Thua Thien-Hue Province; Mr. Huy, Forest 
Protection Department, Thua Thien-Hue Province; and Mr. Linh, Sub-FIPI in Thua Thien-
Hue Province. 

The project team would like to thank Hoang Ngoc Khanh, Director of Thua Thien-Hue 
Provincial Forest Protection Department, Dr. Chris Dickenson and Ms. Tran Minh Hien, 
WWF, for their support and input to this process. 

 

 

 



EO-STEM Milestone Report 7 1 Hatfield 

1.0 INTRODUCTION 

This document was produced as part of the Earth Observation Support for 
Traditional Ecological Mapping and Biodiversity Conservation in Viet Nam (EO-STEM) 
Project. The report fulfills obligations as per Hatfield Consultants Ltd.’s EOADP 
contract with the Canadian Space Agency (Contract No. 9F028-4-5007/01). 

The main objective of the EO-STEM Project is to provide technical support to the 
Government of Viet Nam through the Green Corridor Project (GCP), which is 
being implemented by the World Wide Fund for Nature (WWF) and the 
Government of Viet Nam (Thua-Thien Hue Province and the Forest Protection 
Department). The goals of the EO-STEM project are directly linked with those of 
the GCP, which aims to maintain and sustain the rich biodiversity of the Green 
Corridor area in Thua Thien-Hue province, Viet Nam. A key output and focus of 
the project is training and capacity building for WWF, Thua-Thien Hue Province 
and GCP partners. 

The objective of this document is to provide a practical guide for conducting 
ground surveys or fieldwork associated with interpretation or classification of 
remote sensing imagery for biodiversity conservation; hereafter referred to as 
field data survey. The guide is based on experience gained collecting such data 
in several areas of the world for different applications, but focuses on field data 
survey conducted in Thua Thien-Hue Province with staff from several Provincial 
and National Departments and Institutes.  

Specific aims of this document are: 

� To provide basic principles for conducting field data surveys; 

� Provide a general protocol for field data survey; 

� Provide practical demonstration of field data survey planning, data 
collection, and processing; and 

� Provide example remote sensing data and identify tools for working with 
the data. 

This document does not provide details regarding statistical theory of sampling, 
geographical distribution of sampling, or details of how to address the issue of 
spatial autocorrelation. These issues are mentioned in the text, and references are 
provided if the reader desires more information. 
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2.0 BASIC PRINCIPLES OF FIELD DATA SURVEY 

2.1 THE NEED FOR A FIELD DATA SURVEY 

Conducting a field data survey is based on a need for systematic data regarding 
the land cover of an area that one wishes to investigate using satellite imagery. 
The user’s needs may be as diverse as, the production of a thematic land cover 
map, understanding areas of land cover change, or simply to allow you to 
interpret the information presented in a satellite image.  

Before undertaking a field data survey, it is important to determine the goals and 
objectives of the field program.  If one knows an area very well, or have other 
sources of information available, e.g. recent aerial photographs, then one may not 
need to complete a field data survey. Surveys can be costly, so if other sources of 
information are available, this may reduce the need for a field data survey. 

It is difficult to provide universal rules that can be followed for a field data 
survey, because the objective of the activity, landscape, area of interest, imagery 
used, all influence the way the survey should be conducted.  However the type of 
information collected is not the same as in other disciplines, e.g. biodiversity or 
forestry assessments – such information is to be used specifically for the 
interpretation of satellite imagery. 

2.2 SATELLITE IMAGERY 

Before planning a field data survey, one must evaluate the satellite imagery that 
is available. A number of important questions to consider include: 

1. What is the area of interest for the satellite image or map? 

2. What spatial scale is desired? The size of the study area, the complexity of 
the landscape, and other issues will influence the type of imagery that is 
appropriate. Spatial resolution of imagery will influence the aim of the 
field data survey; for example, Landsat Thematic Mapper (TM) images 
(30 m pixel size) require survey of habitat features that are appropriate for 
the available resolution, whereas Ikonos images (1 m pixel size) may 
require identification of smaller landscape features such as individual 
houses, fields, plant communities or trees. 

3. What types of imagery are available and what is the available budget to 
buy new imagery?   

4. What is the season and year of available archive images; are they suitable 
for observing the features that are required for the objectives of the study? 

Usually, some compromises will be made because of availability of imagery, 
software tools, resources for purchase and analysis of imagery, and resources for 
conducting the field data survey. A useful introduction to satellite imagery and 
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planning satellite imagery projects can be obtained from the Center for 
Biodiversity and Conservation (CBC) Remote Sensing and GIS lab, which is part 
of the American Museum of Natural History (AMNH):  

http://geospatial.amnh.org/ 

2.3 CLASSIFICATION SYSTEM 

A classification system for land cover mapping refers to the discrete thematic 
land cover classes that are the aim of the mapping exercise. A well thought out 
and well-defined system is essential for any successful mapping exercise. Some 
important considerations are: 

� Be realistic – the system must be appropriate for the imagery available 
and the capacity of the remote sensing data to discriminate those classes. 
Note that detailed ground-based classification systems for ecological or 
forestry disciplines are often unrealistic when working with satellite 
imagery, and if they are to be used they often require some form of 
aggregation; and 

� Reduce ambiguity – the classification system must have clear definitions. 
During the ground survey, it should not be difficult to decide which land 
cover class a particular area belongs to, although there will always be 
complex transition zones between land cover classes and areas of mixed 
land cover. 

2.4 PLANNING A FIELD DATA SURVEY 

If the need for a survey has been identified, and the satellite imagery, and other 
resources are available to conduct the proposed work, then detailed planning for 
the field data survey must be conducted. As part of identifying the need for a 
field data survey, existing topographic and vegetation maps and other spatial 
data should have been compiled and consulted in advance. These maps and data 
are essential tools for planning a field data survey. The requirements of the 
planning process will be specific to the project, but some general activities should 
be conducted include: 

1. Assemble your proposed field data survey team – discuss ideas regarding 
locations that are important to study, and review the classification 
system; 

2. Consult the available maps and satellite imagery – identify areas of 
particular interest or uncertainty with regard to information and land 
cover types in the satellite image; 

3. It may be useful to complete an ‘unsupervised classification’ on available 
imagery in advance of the field data survey, in order to understand the 
potential distribution of land cover types and areas of uncertainty; 

http://geospatial.amnh.org/
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4. Determine the logistical requirements (e.g., boat, vehicle, helicopter, etc.) 
that are necessary to conduct the field data survey safely and efficiently; 

5. Propose a route for the field data survey (e.g., by vehicle), estimate the 
number of days required, and locations for overnight stays; 

6. In each area where fieldwork will be conducted, research the ground 
conditions if they are not known, for example whether access is by 
4-wheel drive, motorbike, or on-foot; 

7. Consult with local officials regarding your field survey plan, and take 
advice from people who know the area; 

8. Always plan for delays and make sure you have a contingency plan if 
issues such as bad weather, access restrictions or injury cause delays 
during parts of your trip; and 

9. Follow appropriate safety protocols for your fieldwork. 

2.5 SAMPLING FREQUENCY AND DISTRIBUTION 

There are no strict rules related to sampling frequency and distribution of 
samples. Properties of landscape (in terms of topography and variation in land 
cover) mean that the requirements of field data surveys are often specific to the 
area of interest. In a complex and mountainous landscape, the land cover and 
topography may change over short distances, allowing the collection of 
information on different land cover types over smaller areas. In contrast, much 
larger distances may need to be covered to assess different land cover types in 
more homogenous areas, for example, large areas of grassland. 

The survey should aim to record multiple observations of land cover types for 
each of the classes identified in the classification system. Rare land cover classes 
might be less frequently observed, but may require a special effort in order to 
improve confidence in the satellite imagery interpretation. A review of sampling 
considerations is provided by Lillesand and Kiefer (1994). 

It is important to remember the objective of the field data survey, is related to the 
interpretation of satellite imagery. In general, this means that you should aim to 
survey a range of locations within your overall area of interest and collect ‘well-
spaced’ observations in those areas. With geographic sampling, the issue of 
spatial autocorrelation when is important – two observations quite close to each 
other (e.g., in the same patch of forest) cannot be considered independent, which 
is a requirement for certain statistical analysis. A general rule is to record 
observations when moving into new habitat areas, or when you have moved into 
a new landscape area (e.g. new slope aspect, new valley, etc.) if in the same 
habitat type.  
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2.6 SURVEY EQUIPMENT 

There are many general equipment requirements for fieldwork, e.g. those related 
to general safety and navigation. A field data survey requires additional 
equipment, examples of which are given in Section 4.0, these include: 

� A well-designed data collection form – this can improve the accuracy and 
efficiency of fieldwork, and can also make computer data entry easier; 

� Global Positioning System (GPS) – there are a variety of handheld GPS 
units that are available that allow the user to save each observation 
position (waypoint), which can be exported later to a file for processing 
once the fieldwork is complete; 

� Digital Camera – with high picture resolution, e.g. at least 3.2 mega-pixel, 
preferably with  a date and time stamp; 

� Compass – to record the bearing of each photograph (optional); 

� Wrist watch – to record the time of observations, which can be cross-
referenced with the GPS waypoint and photograph acquisition time; and 

� Imagery and/or maps – it is helpful to have printouts of imagery during 
the fieldwork in order to identify areas of particular interest in the 
imagery; if possible, they should be laminated to protect them from the 
elements. 

2.7 REQUIREMENTS FOLLOWING A SURVEY 

Following a survey, careful compilation of data is required. Specific activities 
depend on the type of GPS, spreadsheet software and GIS software available; 
however, there are some general rules, as follows: 

� Compile the data as soon as possible, while the field experience is ‘fresh’ 
in the memory; 

� Provide metadata, or descriptions of all files and folders, when you 
compile the data; 

� Always keep the original GPS data and photographs – don’t delete them! 
and; 

� Back-up all the data to a CD and label it appropriately. 
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3.0 LAND COVER SURVEY IN THUA THIEN-HUE, VIET NAM 

3.1 OBJECTIVE 

As part of the EO-STEM project, a field data survey was organized to gather field 
data in Thua Thien-Hue Province, Viet Nam, particularly within the Green 
Corridor. The aim of the surveys was to collect information that could be used to 
create a new land cover map of the province based on updated satellite imagery. 
The need was based on the fact that existing maps were out-of-date and did not 
provide the necessary detail regarding land cover classes. The final land cover 
map will be used as part of a conservation planning process. 

The planning and implementation of the survey were influenced by factors 
discussed above in Section 2.0, in particular: 

� Desired classification system – the provincial government requires that 
the classification system follow that created by the Ministry of Natural 
Resources and Environment (MONRE); 

� Landscape and challenges of logistics – the province is quite 
mountainous in some places and access can be difficult. Careful planning 
was required involving experienced surveyors from the Provincial Forest 
Inventory and Planning Group (FIPG); and 

� Satellite imagery – through EO-STEM, the area of interest was covered by 
two new satellite images acquired from the SPOT-5 satellite, which are 
4-band multi-spectral (visible and near-infrared wavelengths) with 
10 metre spatial resolution. The images were acquired in July 2004 and 
February 2005 and covered almost all of the area of interest (as shown in 
Figure 1). Difference in the year of acquisition was not considered 
important based on landscape change, but there were some noticeable 
differences in the imagery related to the growth stage of crops in 
agricultural areas – this seasonal variation needs to be taken into account 
during the interpretation stage.  

For more information of the satellite imagery and the classification of land cover 
as part of the EO-STEM Project, please refer to EO-STEM Technical Report: 
Milestone 7 - Remote Sensing Classification of Thua Thien-Hue Forest Cover 
(Hatfield Consultants Ltd, 2006). 
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Figure 1  Area of interest and coverage of SPOT imagery, Thua Thien Hue 
Province, Viet Nam. 

 

3.2 CLASSIFICATION SYSTEM 

The field data survey for Thua Thien-Hue was based on the Vietnamese system 
for Classification of Evergreen Natural Wooden Forest from the Ministry of Natural 
Resources and Environment. This system was developed for forestry related 
purposes and is a hierarchical system.  

A graphical representation of the hierarchical classification system is presented in  
Figure 2; the definitions of the classes are provided below in Table 1.  From a 
remote sensing perspective, the classification system required simplification 
because certain forest classes would not be easily distinguishable from the 
available remote sensing imagery.  Furthermore, for the area of interest, there 
were no forest areas considered pristine (Group IV). Based on discussion with 
end-users of the final map and local forestry specialists, certain classes were 
identified as high priority, which meant that they were included as target classes 
for the remote sensing work. In addition to the forest classes, additional land 
cover classes were recorded, such as plantation forest, agricultural land and bare 
ground. 
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Figure 2 Vietnamese Classification of Evergreen Natural Wooden Forest 
(Ministry of Natural Resources and Environment). 

Evergreen Natural Wooden Forest 

I 
Non-forest 

II 
Regenerating Forest

III 
Impacted Forest 

IV 
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IA IB IC IIA IIB IIIA IIIB
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Table 1 Class definition for Vietnamese Classification of Evergreen Natural 
Wooden Forest (Ministry of Natural Resources and Environment). 

Group I: Non-forest. Only grasses, bushes with very few trees, scattered bamboos; coverage index is under 0.3. 
This group has 3 sub-groups: 

IA: Characterized by grasses, bushes or wild bananas. 

IB: Characterized by bushes, scattered wooden trees and bamboos. 

IC: Characterized by high density regenerating trees. Trees taller than 1m and more than 1,000 trees/ha. 

Group II: Regenerating forest with pioneer species that have smaller diameter. 
Based on status and origin, there are 2 sub-groups: 

IIA: Regenerating forest after agricultural activities, characterized by pioneer species that are fast growing and prefer 
light. Trees are of similar age and there is only 1 story. 

IIB: Regenerating forest following heavy exploitation for timber. Young community with species preferring light; 
diverse species composition; trees of different ages; dominance is not clear. There are maybe some big trees 
remaining, but the numbers are not relevant. Forest is only classified into this group if the community with the 
commonest diameter not more than 20cm. 

Group III: Impacted secondary forest. Communities have been exploited, which has changed the structure of the 
forest. Depending on exploitation levels and the potential products, there are two sub-group recognized: 

IIIA: Heavily exploited communities; present potential for exploitation is limited and the structure of the forest is 
significantly changed. There are 3 sub-groups: 

IIIA1: Most heavily exploited forest. The upper story may have some large trees, but generally the forest is of 
low quality with numerous of vines, bushes, and bamboos. 

IIIA2: Heavily exploited, but significant time for regeneration. Characterized by the middle story becoming 
dominant with majority of trees in this story having a diameter of 20-30cm. The forest has at least 2 stories; the 
upper story coverage is not continuous, being mostly established by the trees from the lower story before; there 
are maybe a few large trees. 

IIIA3: Exploited forest or forest developing from IIIA2. The communities have a relatively closed coverage, 
having at least 2 stories. The main difference form type IIIA2 is the number of trees is higher and there are some 
trees with diameter more than 35cm. 

IIIB: Characterized by communities that have been selectively logged, with some valuable wooden species exploited. 
The stable structure of the forest hasn’t changed; biomass is high with a high percentage of large trees.   

Group IV: Pristine forest, stable forest. Pristine forest or matured secondary forest that hasn’t been exploited. The 
forest has a stable structure, multi-story, diverse diameter sizes, but sometimes lacking lower story. 
There are 2 sub-groups: 

IVA: Pristine forest 

IVB: Regenerating secondary forest. 

Note: Translated and provided to EO-STEM by GCP (2006). 

3.3 AREA OF INTEREST AND SURVEY PLAN 

The area of interest for the EO-STEM project is the Green Corridor Project area 
with the Province of Thua Thien-Hue; however, a map covering the entire 
forested area of TT-Hue was required. 

Figure 3 shows the extent of the satellite imagery, provincial administrative 
borders, the Green Corridor boundary and the general locations of the field data 
surveys. The surveys were designed to cover the whole range of land cover 
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classes required and a range of elevations. Some observations were obtained in 
close proximity to paved roads, but access to other areas required 4-wheel drive, 
or hiking along trails. 

Within each survey area, individual waypoints were collected according to the 
general principles identified in Section 2.0. 

Figure 3 Location of field data surveys conducted as part of the EO-STEM 
project in Thua Thien-Hue Province, Viet Nam. 

 

3.4 SURVEY TEAM 

The field data survey was conducted in March 2006 by a team including: 

� Dr. Andy Dean and Mr. Pierre Dubeau (EO-STEM; Hatfield Consultants 
Ltd.); 

� Dr. Do Xuan Lan (FIPI); 

� Mr. Huy (Hue FPD); 

� Mr. Phong (Hue FIPG); and 

� Mr. Linh (Sub-FIPI). 
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4.0 PROTOCOL FOR FIELD DATA SURVEY 

It is very important to establish a protocol for the field data survey; each team 
member must understand their role, and adhere to the protocol. The following 
sections describe the protocol followed during the EO-STEM field data survey, 
and provide some suggestions when conducting field data surveys. 

4.1 EQUIPMENT SETUP 

GPS: 

� Take one, or preferably two, GPS units to the field; 

� Make sure you know how to use the GPS – read the instructions; 

� Set up the GPS with the appropriate coordinate system for your mapping 
work; 

� Check the memory and download and archive any waypoints that 
remain in memory; 

� Take spare batteries – do not buy low quality batteries! and 

� Set up the GPS to store tracks – make sure you have enough memory to 
store the total number of track points from your survey. Adjust the time 
interval between track points based on the estimated time in the field, 
and the amount of memory, to ensure tracks do not get over-written. 

Camera: 

� Make sure your camera has sufficient memory to store up to several 
hundred high quality photographs; 

� Set the camera date and time accurately; 

� Set the camera picture quality to high resolution (e.g. at least 3.2 mega-
pixel); 

� Take spare batteries – do not buy low quality batteries! and 

� Take a back-up camera and additional memory (if possible), in the event 
of technical problems. 

Data collection form: 

� Print sufficient data collection forms; 

� Use water resistant paper, if possible (e.g. ‘Rite In the Rain’); 

� Write with a pencil; and 

� Bring copies of field maps, laminated if possible. 
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4.2 DATA COLLECTION FORM 

The EO-STEM data collection form was developed using an Excel spreadsheet; 
see Appendix A1 for a copy of the form. The form has fields for collection of 
general information and waypoint information. The form fields are defined 
below and the protocol for completion of each form is described in Section 4.3. 

4.2.1 General Information 

The following information should be recorded at the start of each survey day and 
on each data collection sheet: 

� Team Members – the names of all members of the survey team; 

� Date – the date of the survey; 

� Camera – the ID of the camera used, which may be important if a 
department or organization has several cameras used for surveys; and 

� Co-ordinate System – the projection, datum, and co-ordinate system 
used for the field data collection. 

4.2.2 Waypoint Information 

The following describes information that should be recorded when waypoints 
are collected: 

� GPS Unit – the ID of the GPS unit used, which may be important if a 
department or organization has several GPS units used for surveys; 

� Waypoint – the waypoint number for the GPS used (i.e. 001, 002, 003, 
etc.); 

� GPS Time – time in hours, minutes, seconds recorded from the GPS 
(i.e., hh:mm:ss); 

� Photo Time – time the photo was taken in hours and minutes, using a 
wrist watch (i.e. hh:mm); 

� Bearing – photo bearing in degrees (i.e. 0 to 360°) in the direction of the 
class being described; 

� Distance – estimated distance to the class being described in increments 
of 500 m (i.e. 500, 1000, 1500, etc.); 

� Check boxes for each land cover class – the codes must be well defined 
and understood by all members of the survey team; 
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� Description – additional description of the land cover, including the 
name of other classes recorded in the vicinity (e.g. plantation) or context 
information; and 

� Sketch Box – additional information on the surrounding features can be 
schematically drawn.  This can also be a useful area to indicate the 
location of the collected waypoint, for geo-metric validation. 

4.3 DATA RECORDING PROTOCOL  

The data collection form should make information collection straightforward and 
reduce uncertainty and errors in data recording. The continuous recording of 
tracks allows the survey team to re-trace the entire field collection route, which 
could be useful when interpreting the satellite imagery.  Individual waypoints 
are collected at locations of a specific land class or area of interest.  Below are 
some basic steps to follow, which will improve the ability to use the field data 
collected: 

1. Preparation: 

� Create a new GPS track at the start of the day. Make sure that the 
maximum number of tracks is high enough so that the whole day can be 
tracked at the desired observation frequency (e.g. 15 second track 
intervals for 8 hours requires capacity for 1,920 tracks); 

� Record the Date, Team Members and Camera used at the top of every 
data collection form; 

� Check that the camera date and time are correct; and 

� Check that the camera is set to take maximum resolution photographs 
(at least 3.2 mega-pixels). 

2. Data Collection at a waypoint location: 

� Record a waypoint at each survey location and record the GPS unit ID 
and the waypoint number; 

� Record GPS time; 

� Record photo time. If more than one photo is acquired, use a new row 
on the data collection form for each photo, and record the new time for 
each photo; 

� Record the bearing of each photo. If you are recording a land cover type 
that is “all around ” the waypoint location, record “999” for the bearing; 
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� When recording data, complete a new row for each waypoint, photo, or 
class; 

� Estimate the distance to the class; 

� Record the land cover class by ticking one box only; and 

� If a location and/or photo has more than one class that you wish to 
record, complete a new row in the data collection form for each class 
and photo. 

3. Using a hard copy map: 

� At each waypoint, if you have a large scale topographic map or image, 
you may wish to record your route (track) and each waypoint on the 
map in an approximate position, for example using the GPS 
coordinates; and 

� Also, you may wish to mark on the map the feature that you were 
describing, especially if this feature was on a facing slope of a valley. 
This will aid the interpretation of the photographs, bearing and distance 
information recorded on the field data sheet. 

4. Follow up: 

� At the end of the day, review the collected information to make sure it is 
clear and all information required was recorded; and 

� If possible, download the GPS tracks, waypoints, and photographs to a 
computer. 

The above steps describe the protocol for the collection of field data using a 
manual technique. Data collection and attributing can also be captured digitally, 
using Personal Digital Assistant (PDA) devices and specialized software. This 
will be discussed further in Section 6.0. 
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5.0 PROCESSING OF FIELD DATA 

The processing of collected data will vary according to the type of GPS unit and 
the software packages available. 

5.1 DOWNLOADING GPS DATA 

Useful free software for working with GPS data includes GPSTrackMaker, which 
was developed by Odilon Ferreira Junior (www.gpstm.com); another popular 
free package is OziExplorer (www.oziexplorer.com). Depending on your model of 
GPS, it may be better to use the software that comes with your GPS unit (e.g. 
Garmin Mapsource).  It is also useful to note that ArcMap v9 offers GPS support 
that allows for the direct connection to a GPS unit and real-time data collection 
and digitizing. 

The following are guidelines for processing GPS waypoint data: 

1. Create a folder called GPS_Data; 

2. In a sub-folder (e.g. Raw), store the GPS data in its raw or native format; 

3. In a sub-folder (e.g. Excel), use GPS software to save the Waypoints and 
Tracks as comma delimited text files. Or by using Excel, save the files as a 
*.xls files (Tracks.xls, waypoints.xls). 

� Waypoints.xls should have the following fields: WpN, X, Y, GPSUnit, 
Date, Time, and Elev. 

� Tracks.xls will have x, y, GPSunit, date, time, and elevation fields, but 
unfortunately some GPS software tools do not import the time, date 
and elevation data for tracks. 

5.2 FIELD DATA ENTRY 

Data should be transferred from the data collection forms into an Excel 
spreadsheet manually, as follows: 

1. Create a folder called Survey_Data; 

2. Create an Excel file called SurveyData.xls, which will be a template for data 
transfer from the data collection forms. A sample spreadsheet is provided in 
Appendix A2. 

� SurveyData.xls will have the following fields: Date, GPSUnit, Camera, 
WpN, GPSTime, PhotoTime, Bearing, Distance, Class, and Description. 

� WpN needs to contain unique values (primary key). If you have two 
waypoints with the same number, then create a suffix to the waypoint, 
e.g., a001, b001, where “a” and “b” are the GPSUnit. 

http://www.gpstm.com/
http://www.oziexplorer.com/
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5.3 PHOTOGRAPHS 

A crucial process is providing the correct basis to link the photographs taken to 
the collected waypoints. 

1. Download the photographs from the camera into a folder called Photos; 

2. Modify and rotate the photos as required. Note that this will reset the Date 
Modified for the photo, which should be reset to the date and time that the 
photo was taken (the EXIF date).  Useful software to use is Thumbplus 
(www.cerious.com), which has a free 30-day trial; 

3. Create a text file called PhotoCatalog.txt containing a list of the all the 
individual photo file names and their directory path. This can be completed 
in a number of ways, for example using MS Outlook; 

a. Select ‘Advanced Find’ from the ‘Tools’ menu and select ‘Files’ from the 
‘Look for’ drop down list box and select ‘All Files (*.*)’ from the  ‘Of type’ 
drop down list box; 

b. Click on ‘Browse’ and navigate to the directory containing all field 
photos taken from field data survey, and click on ‘Find Now’; 

c. The search results will be listed at the bottom of the ‘Advanced Find’ 
dialog box and will have both the file names and their directory path; 
and 

d. Select all results and copy/paste them in an Excel spreadsheet for 
further manipulation and sorting; 

4. Create an Excel file called PhotoCatalog.xls, which has the following fields: 

a. WpN, PhotoName, Path, and DateTime; and 

b. Create an additional field called “Hyperlink” or “Path”, which has the 
full file path and name (e.g., C:/myfielddata/photos/photo1234.jpg); 

5. The Final stage is to enter the waypoint number for each photo, matching the 
Date and Time of the Photo and those from SurveyData.xls. A separate field 
should be created containing the waypoint. 

See photo catalogue in Appendix A3 for an example of the result of these steps. 

http://www.cerious.com/
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5.4 CREATION OF GIS DATA 

5.4.1 ArcGIS 9x 

The instructions herein are based on the creation of GIS data in an ESRI Shape 
format using ArcGIS 9x. Following the previous steps, we have four files: 
PhotoCatalog.xls SurveyData.xls, Tracks.xls, and Waypoints.xls. 

To create a Shapefile of Waypoints and Tracks, complete the following: 

1. In Excel, select the records that you would like to export as shapefile.  Save 
this selection as *.dbf version IV format; 

2. Ensure that the *.dbf file contains a minimum of two fields: one for the x-
coordinate and one for the y-coordinate.  The values in these fields must be 
numerical; therefore, geographic coordinate (e.g. latitude and longitude) 
must be represented as decimal degrees. Make sure you format the numeric 
data columns with the correct number of decimal places before you save as 
the *.dbf file; 

3. Open ArcMap; 

4. Load the new table in ArcMap using the ‘add data’ button; 

5. In the Table of Contents (layers list), right-click the file name and choose 
Open to view the table, and check that the data were imported correctly; 

6. To import the tabular data containing geographical locations, selected ‘Tools > 
Add XY data’. Choose the x and y fields, and select the appropriate coordinate 
system, which was identified during the GPS collection; 

7. Click OK to visualize the XY data as a layer within ArcMap; and 

8. To permanently create the layer containing the XY data it must be exported to 
a shapefile.  Right-Click the layer name in the table of contents and select ‘Data 
> Export’. 

5.4.2 ArcView 3x 

The following instructions describe the steps involved in creating an ESRI 
shapefile using ArcView 3x: 

1. In Excel, select the records that you would like to export as shapefile.  Save 
this selection as *.dbf version IV format; 

2. Ensure that the *.dbf file contains a minimum of two fields: one for the 
x-coordinate and one for the y-coordinate.  The values in these fields must be 
numerical, therefore geographic coordinate (e.g. latitude and longitude) must 
be represented as decimal degrees. Make sure you format the numeric data 
columns with the correct number of decimal places before you save as the 
*.dbf file; 
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3. Open ArcView 3x; 

4. Add the table to the existing active project by selecting ‘Add Table’ from the 
‘Project’ menu; 

5. In the Table of Contents (layers list), open to table and check that the data 
were imported correctly; 

6. Select ‘Add Event Theme’ from the ‘View’ menu, and choose the x and y fields, 
and select the appropriate coordinate system, that was identified during the 
GPS collection; 

7. Click OK to visualize the Event Theme as a theme in ArcView; and 

8. To permanently create a shapefile, the Event Theme must be exported to a 
shapefile.  Select ‘Export’ from the ‘File’ menu. 

5.4.3 Appending Attributes 

The next step is to link SurveyData.dbf to Waypoints.shp: 

1. Add SurveyData.dbf and Waypoints.shp to ArcMap using the ‘add data’ 
button; 

� In the Table of Contents (layers list), right-click on Waypoints.shp and 
choose ‘Joins and Relates > Join’; 

� Choose WpN as the attribute field that the join will be based upon; 

� Choose SurveyData.dbf as the layer that the table will be joined with; 

� Choose WpN as corresponding attribute field in SurveyData.dbf that the 
join will be based upon; and 

� Click OK. 

2. To permanently join the attributes to Waypoints.shp, the layer must be 
exported to a new file. 

5.5 GEOCODING GPS PHOTOGRAPHS 

To create a shapefile with hyperlinked photographs, both the PhotoCatalog.xls 
and the Waypoints.shp are needed.  As indicated above, the following fields 
that should be present in the PhotoCatalog.xls and Waypoints.shp file 
respectively are: 

� WpN, PhotoName, Path, Date, and Time; and 

� WpN, X, Y, GPSUnit, Date, Time, and Elevation. 
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The process of creating a shapefile from tabular XY data is described in the 
previous section, therefore the steps involved in creating hyperlinks to the 
photographs are: 

1. Open PhotoCatalog.xls in Excel and select the records that you would like to 
export as shapefile.  Save this selection as *.dbf version IV format; 

� Ensure that the *.dbf file contains a minimum of two fields: one for the x-
coordinate and one for the y-coordinate.  The values in these fields must 
be numerical. Make sure you format the numeric data columns with the 
correct number of decimal places before you save as the *.dbf file; 

� Add PhotoCatalog.dbf and Waypoints.shp to ArcMap using the ‘add 
data’ button; 

� In the Table of Contents (layers list), right-click on Waypoints.shp and 
choose ‘Joins and Relates > Join’; 

� Choose WpN as the attribute field that the join will be based upon; 

� Choose PhotoCatalog.dbf as the layer that the table will be joined with; 

� Choose WpN as corresponding attribute field in PhotoCatalog.dbf that 
the join will be based upon; and 

� Click OK. 

3. To permanently join the attributes to Waypoints.shp, the layer must be 
exported to a new file; 

4. To activate the hyperlinks feature in ArcMap, right-click the new shapefile 
and select ‘Properties’. In the ‘Layer Properties’ dialog box, choose the ‘Display’ 
tab and check ‘Support Hyperlinks using field’.  In the drop down menu, choose 
the field that contains the directory, path and filename of the digital photo, 
(e.g. Path); and 

5. Click OK. 

5.6 RESULTS OF THE THUA THIEN-HUE SURVEY 

The tracks for the field data survey conducted in TT-Hue are shown in Figure 4. 
During the two field data surveys, the following was completed: 

� A total of 6 days were spent in the field; 

� Over 100 waypoints were collected; and 

� Several hundred photographs were taken. 



EO-STEM Milestone Report 7 20 Hatfield 

The survey covered several areas distributed across the Province and in the 
Green Corridor. Due to logistical and topographic constraints, some areas were 
inaccessible to the field team.  Careful research regarding the accessibility of 
areas meant that the field survey was completed as planned, and the desired 
range of land cover types were visited and waypoints recorded. The field survey 
data was used in a classification of forest and land cover for Thua Thien-Hue 
Province, using satellite imagery from SPOT-5; the results of this work are 
detailed in the EO-STEM Technical Report: Milestone 7 - Remote Sensing 
Classification of Thua Thien-Hue Forest Cover (Hatfield Consultants Ltd, 2006). 

Figure 4 Survey tracks from the EO-STEM field data survey, Thua Thien-Hue 
Province, Viet Nam. 
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6.0 FUTURE WORK 

Data collection and real-time information gathering and digitizing can now be 
effectively done digitally using PDA devices and specialized software. ESRI 
ArcPAD, for example, provides support for industry standard vector and raster 
image display and allows for the use of satellite images (in combination with 
other GIS layers) in the field, as a base to collect information.  The interface with 
the GPS allows for real-time navigation and recording of geographic locations. 

There are many other software packages available for real-time data collection 
that can be used on PDA devices or laptop tablets.  A few are OziExplorerCE, 
VITO SmartMap, and Virtual Earth Mobile (VEM). 

Using such tools, most steps described in this report could be completed in the 
field, reducing the amount of time for data management, preparation, and post-
data collection processing. 

Figure 5 Data collection using integrated PDA and GPS devices. 

 

 



EO-STEM Milestone Report 7 22 Hatfield 

Figure 6 EO-STEM team members recording data in real-time. 

 



EO-STEM Milestone Report 7 23 Hatfield 

7.0 FURTHER INFORMATION AND REFERENCES 

For more information on field data survey, GPS and mapping ideas, remote 
sensing, see the following sources of information: 

� Remote Sensing and GIS Lab, Center of the Biodiversity and 
Conservation, American Museum of Natural History. The Remote 
Sensing and GIS lab is a leader in developing and promoting the effective 
use of geospatial tools by amateur and professional conservation 
practitioners – see http://geospatial.amnh.org/. 

� Lillesand, T.M. and Kiefer, R.W. (1994) Remote Sensing and Image 
Interpretation, John Wiley and Sons, Inc, - this book provides a great 
introduction to Remote Sensing, including some information on 
surveying and sampling. 

� Mapping Hacks by Erle, Gibson and Walsh (2005), O’Reilly Media, Inc. 
There are many ways and techniques used in mapping GPS data. For 
interesting and fun techniques in mapping your GPS waypoints and 
tracks, as well as geo-referencing digital photos, Mapping Hacks has 
some great ideas. For more information please refer to 
http://mappinghacks.com/. 

http://geospatial.amnh.org/
http://mappinghacks.com/
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8.0 CLOSURE 

Hatfield Consultants Ltd.: 

 

Approved by:  August 8, 2006 

 Thomas G. Boivin, Project Director Date 
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 Dr. Andy Dean, Project Manager Date 
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Appendix A1 
  

Data Collection Form 



Classification of Evergreen Natural Wooden forest: 4 groups
Date: Camera:

Team members:

A B C A B A1 A2 A3 BWaypoint DescriptionGPS
Unit GPS Time Photo Time Bearing 1 2 3Distance
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Sample Field Data 



EO-STEM Survey Data: March 2006

Date GPSUnit Camera WpN GPSTime PhotoTime Bearing Distance Class Description
1-Mar a 1 a002 15:48:53 40° 200 31 Patch (size?) at a distance, ~ 200 m
1-Mar a 1 a002 15:50:18 340° 150 1b ~ 150 m distance
1-Mar a a002 15:50:18 340° 200 31 Patch (size?) at a distance, ~ 200 m
1-Mar a 1 a004 16:05:38 190° 100 31 On top of mountain, ~ 100 m from settlement on the right side
1-Mar a 1 a004 16:08:40 230° 300 2b On the top … ~ 300 m
1-Mar a 1 a004 16:14:06 215° 1b Behind settlement
1-Mar a 1 a004 16:14:46 230° 1a Road in centre
1-Mar a 1 a004 16:16:06 160° 99 Paddy
1-Mar a 1 a005 16:46:51 195° 99 Cinnamon plantation in village settlement
1-Mar a 1 a005 16:47:44 100° 99 Fields - cinnamon in background
1-Mar a 1 a005 16:48:06 110° 99 Fields - cinnamon in background (no entry in datasheet)
3-Mar a 2 a007 10:15:25 215° 75 99 Acacia - 6 years old
3-Mar a 2 a007 10:18:08 215° 75 99 Acacia - 6 years old
3-Mar a 2 a008 10:39:08 999° 99 Acacia all around - 8 year old
3-Mar a a011 11:10:49 666° 1a Left plantation, entering new forest class (1a)
3-Mar a 1 a013 11:26:02 180° 31 Left forest class (1c) moving into (31)
3-Mar a a014 11:34:11 999° 0 1a Around trail (~ 50 m radius), small patch
3-Mar a 1 a015 12:14:27 190° 0 31 Along trail
3-Mar a 1 a016 12:31:30 190° 200 31 Whole photograph (200 m)
3-Mar a a017 12:45:19 999° 31 Was logged 'long time ago' …
3-Mar a 1 a018 13:10:06 170° 31 Along trail
3-Mar a 1 a019 14:32:30 200° 1c Patch showing at bottom of photo; plantation visible on the west side (right)
3-Mar a 1 a019 14:32:54 230° 31 Patch on the top
3-Mar a 1 a019 14:32:54 200° 31 High elevation (1 km)
4-Mar a 1 a022 09:11:58 25° 1a General landscape
4-Mar a 1 a022 09:12:01 1a Close up on the team standing on steep slope (unknown bearing)
4-Mar a 1 a022 09:17:26 310° 1a General landscape
4-Mar a a023 09:18:53 260° 1,200 1a Plantation at 1,200 m (opposite), east facing; Altitude 190 m
4-Mar a 1 a024 09:37:52 210° 0 1b 1b all around
4-Mar a 1 a025 09:51:05 30° 0 2b 2b forest all around 
4-Mar a 1 a026 10:06:48 235° 0 31 2b forest all around; very large trees left
4-Mar a a027 10:27:33 0 31 31 forest all around
4-Mar a 1 a028 10:41:58 20° 0 2b Transition 2b to 31
4-Mar a a029 10:47:47 0 31 All around
4-Mar a 1 a030 11:15:16 125° 0 31 All around
4-Mar a a031 12:49:08 0 31 All around
4-Mar a 1 a032 13:03:14 340° 0 31 All around
4-Mar a 1 a033 15:01:53 100° 100 Looking at plantation edge with natural forest 100 m to west slop
5-Mar a 1 a034 10:04:36 190° 2b Bottom left part
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Date GPSUnit Camera WpN GPSTime PhotoTime Bearing Distance Class Description
5-Mar a 1 a034 10:04:36 190° 31 Top
5-Mar a 1 a034 10:06:54 340° 1c Bottom
5-Mar a 1 a034 10:06:54 340° 31 Top
5-Mar a 1 a035 10:20:22 300° 150 1c Foreground (~ 150 m)
5-Mar a 1 a035 10:20:22 300° 1,500 31 1,500 m in distance
5-Mar a 1 a036 10:59:59 180° 150 2b
5-Mar a 1 a037 11:37:29 270° 300 31
5-Mar a 1 a038 11:54:48 200° 31 Patch covering the whole slope
5-Mar a 1 a039 12:03:26 130° 70 1b Shrub after shifting cultivation 
5-Mar a 1 a039 12:05:06 90° 100 100 m in distance; hill in distance is (1b) to (1c) on top
5-Mar a 1 a040 12:51:06 55° 1b Forest station, some small planted at station - same as wpt 39
5-Mar a 1 a041 13:53:50 195° 31 31 forest at the top & 2b forest down
5-Mar a 1 a041 13:54:32 Area next to Photo-1 (previous), to the right; no bearing, no forest classes
5-Mar a 1 a041 14:02:06 Slope with degraded forest: photo taken around the same time, but no data available
5-Mar a 1 a043 14:08:48 30° Planted & '1a' to '1c' mosaic
5-Mar a 1 a043 14:10:53 250° 1a 1a forest with some plantation; jeep in picture
5-Mar a 1 a044 14:14:22 265° 100 Planted (see 'a043') ~ 100 m in distance
5-Mar a 1 a045 14:19:05 10° 1a to '1c' mosaic; also planted
5-Mar a 1 a046 14:24:54 70° 1a No data on sheet… unsure if this is the right photo***
5-Mar a 1 a046 14:25:09 150° 31 Top: '31'; Lower: '1c'; Left of picture is '1a' bareground;  *photo taken at 14:22:42*
5-Mar a 1 a047 14:35:00 335° 200 1c Patch of typical '1c' forest (~ 200 m in distance)
5-Mar a 1 a047 14:35:16 130° 500 31 31 and '1a' forest to east small planted (~ 500 m in distance)
5-Mar a 1 a047 14:35:22 Extra photo taken less than a minute after previous (1)… see for yourself
5-Mar a 1 a048 14:50:05 150° 31 forest at the top , ~ 3 year old plantation in mid-slope, cultivation at bottom
6-Mar a 1 a049 8:31:40 10° 1a Patch covering the whole slope (note: photo taken at 08:30:32)
6-Mar a 1 a050 8:46:58 10° 2b Patch covering the whole slope
6-Mar a 1 a050 8:47:46 250° 2b Note indicate "whole slope" while the photo shows a patch of planted trees
6-Mar a 1 a051 9:01:13 10° 100 1b 1b patch located ~ 100 m in distance
6-Mar a 1 a051 9:01:13 10° 700 2b 2b forest patch located ~ 700 m in distance
6-Mar a 1 a051 9:01:13 10° 1,000 31 31 forest found at > 1 km in distance
6-Mar a 1 a052 9:34:48 180° 2a Standing in planted forest; '2a' forest on lower facing slope; '31' forest on top
6-Mar a a053 9:57:43 2b Trail goes through '2b' forest; '31' forest on mountain top
6-Mar a 1 a054 10:03:18 320° 31 31 forest on the top; '2b' forest in the bottom
6-Mar a 1 a054 10:03:18 240° 200 31 31 forest on the top; '2b' forest in the bottom (no photo matching description found)
6-Mar a 1 a055 10:49:31 345° 31 Near BMNP Forest Station (FPD sign in photo)
2-Mar b 1 b003 9:11:34 40° 100 1a 1a at lower elevation (~ 100 m in distance)
2-Mar b 1 b003 9:11:34 40° 200 31 31 forest at higher elevation (~ 200 m in distance)
2-Mar b 1 b004 9:30:31 82° 300 31 31 forest at top of mountain (~ 300 m in distance)
2-Mar b 1 b004 9:30:31 82° 200 2a 2a forest at lower elevation (~ 200 m in distance)
2-Mar b 1 b004 9:33:52 100° 100 2b 2b forest at mountain base (~ 100 min distance)
2-Mar b 1 b005 9:49:29 70° 100 31 (~ 100 min distance)
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Date GPSUnit Camera WpN GPSTime PhotoTime Bearing Distance Class Description
2-Mar b b006 10:05:18 999° 0 2b Along trail
2-Mar b b007 10:19:27 235° 0 31 Along trail & '2b' forest on left side of trail (possible)
2-Mar b 1 b008 10:31:51 999° 0 31 31 forest all around
2-Mar b 1 b009 11:02:23 999° 0 31 End of track
2-Mar b 1 b010 13:59:21 250° 150 99 Acacia mangium  (2 or 3 year old)
2-Mar b 1 b010 13:59:38 180° 150 99 Acacia mangium (2 or 3 year old)
2-Mar b 1 b010 14:01:54 105° 250 31 Poor natural forest '31', on top of hill, along road
2-Mar b 1 b010 14:01:54 105° 1b 1b adjacent to highway
2-Mar b 1 b011 14:17:00 75° 200 99 Pine forest ~ 200 m from road
2-Mar b 1 b011 14:17:46 30° 50 99 Cinnamon plantation ~ 50 m from road
2-Mar b 1 b011 14:17:46 30° 200 1c Poor natural forest '1c' on ridge ~ 200 m
2-Mar b 1 b012 14:55:30 155° 2b 2b forest on mid to lower slope elevation & 2a at very bottom; '31' near top
3-Mar b b014 11:06:54 999° 0 1b Thick shrub surrounding
3-Mar b 2 b014 11:06:54 190° No data
3-Mar b 2 b015 11:18:45 110° 0 2b 2b forest all around (large enough …?)
3-Mar b 2 b016 11:33:28 225° 0 31 Some very large trees left
3-Mar b 2 b017 11:52:20 365° 0 31 31 forest all around
3-Mar b 2 b018 13:09:00 195° 0 31 31 forest all around
3-Mar b 2 b019 13:22:57 170° 0 31 31 forest all around
3-Mar b 2 b019 13:23:50 145° 0 31 31 forest all around
3-Mar b b020 13:38:54 999° 0 31 31 forest all around
3-Mar b b021 14:25:52 999° 0 31 31 forest all around
4-Mar b 2 b024 9:09:25 200° 200 31 31 at higher elevation, near mountain top & '1a' at lower elevation, to bottom
4-Mar b 2 b024 9:10:08 210° 200 1a 1c at mid- to lower elevation & '31' at higher elevation
4-Mar b 2 b025 9:51:04 999° 0 31

All around trail (walking uphill); "the local people exploited in the middle of the mountain"… 
4-Mar b 2 b026 10:23:41 230° 0 31 All around trail
4-Mar b 2 b026 10:24:30 180° 0 31 All around trail
4-Mar b 2 b026 10:24:45 100° 0 31 All around trail
4-Mar b 2 b027 11:36:09 340° 0 31 All around trail
4-Mar b 2 b027 11:36:10 170° 0 31 All around trail
4-Mar b 2 b028 12:39:28 310° 0 31 All around trail & crossing stream
4-Mar b 2 b028 12:39:46 130° 0 31 All around; nearby stream ??
4-Mar b 2 b029 13:16:59 240° 0 31 All around; reach 830 m in altitude, near commune boundary
4-Mar b 2 b029 13:20:31 150° 0 31 All around; end of journey
4-Mar b 2 b030 14:20:56 60° 0 31 All around; on the way back
4-Mar b 2 b031 14:28:55 190° 0 31 All around; Dense Forest …
4-Mar b b032 15:21:24 31 1c at the bottom & '1' forest at the top
4-Mar b b033 15:31:11 100° 31 31 at higher elevation & '1b' at lower elevation
5-Mar b b033 15:31:11 80° 99 Planted about 3 year old
5-Mar b 2 b038 10:31:03 300° 500 31 2b at lower elevation, along left field ??
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Date GPSUnit Camera WpN GPSTime PhotoTime Bearing Distance Class Description
5-Mar b 2 b039 10:38:03 315° 300 31 1c at lower elevation & '31' at ~ 500 m in distance
5-Mar b 2 b040 10:49:07 20° 1c 1c at lower elevation, close to the road (30 m in distance) & '31' near the top
5-Mar b 2 b041 11:29:04 115° 150 31 31 on slope ~ 150 m in distance
5-Mar b 2 b042 12:05:30 140° 200 1a 1a forest in depression & '2b' at mid-elevation (200 m)
5-Mar b 2 b042 38781.504 140 200 31 2b at mid-elevation (200 m) & '31' forest on the top
6-Mar b 2 b043 38782.549 95 250 many Plantation at lower elevation & small patch at upper elevation; '31' at upper elevation & 

small patches of '1b' in between

6-Mar b 2 b044 13:23:32 40° 30 1a Patch on slope
6-Mar b 2 b044 13:24:16 330° 99 Planted on top & bareland on left of photo
6-Mar b 2 b045 13:35:26 230° 1a Bareland & plantation on top of hill
6-Mar b 2 b047 13:42:01 20° 99 Planted all the way to the top

A2_SurveyData_March2006.xls 8/8/2006 4 of 4



 

Appendix A3 
  

Sample Photo Catalogue 



EO-STEM Photo Catalog: March 2006

WpN PhotoName Path DateTime Hyperlink
a002 EOS0249.JPG C:\eostem_photo\EOS0249.JPG 3/1/2006 15:45:30 C:\eostem_photo\EOS0249.JPG
a002 EOS0253.JPG C:\eostem_photo\EOS0253.JPG 3/1/2006 15:50:18 C:\eostem_photo\EOS0253.JPG
a004 EOS0254.JPG C:\eostem_photo\EOS0254.JPG 3/1/2006 16:05:56 C:\eostem_photo\EOS0254.JPG
a004 EOS0255.JPG C:\eostem_photo\EOS0255.JPG 3/1/2006 16:08:40 C:\eostem_photo\EOS0255.JPG
a004 EOS0256.JPG C:\eostem_photo\EOS0256.JPG 3/1/2006 16:14:06 C:\eostem_photo\EOS0256.JPG
a004 EOS0257.JPG C:\eostem_photo\EOS0257.JPG 3/1/2006 16:14:46 C:\eostem_photo\EOS0257.JPG
a004 EOS0258.JPG C:\eostem_photo\EOS0258.JPG 3/1/2006 16:16:06 C:\eostem_photo\EOS0258.JPG
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